Programming in Excel: Introduction to VBA 
		　 
	VBA is the acronym for Visual Basic for Applications. It is an integration of the  Microsoft's event-driven programming language Visual Basic with Microsoft Office applications such as Microsoft Excel. By running VBA within the Microsoft Office applications, you can build customized solutions and programs to enhance the capabilities of those applications. A lot of people might not realize that they can actually learn the fundamentals of Visual Basic programming without having a copy of Visual Basic professional. Why? Because there is a built-in Visual Basic Editor in Microsoft Excel, and you can use it to customize and extend the capabilities of MS Excel. The applications you build with MS Excel is called Visual Basic for Applications, or simply VBA.


There are two ways which you could program a VBA, one is to place a command button on the spreadsheet and start programming by clicking the command button, another one is to write Visual Basic functions inside the VB Editor. Let’s start with the command button first. In order to place a command button on the spreadsheet, you need to click View on the MS Excel menu bar and then click on toolbar and finally select the Control Toolbox after which the control toolbox bar will appear. Then you click on the command button and draw it on the spreadsheet.
	[image: http://www.vbtutor.net/Images/progra_jan_21_2008_vba1.gif]
	[image: http://www.vbtutor.net/Images/progra_jan_21_2008_vba2.gif]


 Next, you click on the command button and the Visual Basic Editor will appear. Then you enter the statement as shown in the figure. The first statement will fill up cell A1 to cell A10 with the phrase "Visual Basic" while the second statement adds the value in cell A11 and cell B11  and then show the sum in cell C11. It is that simple.
	[image: http://www.vbtutor.net/Images/progra_jan_21_2008_vba3.gif]
	

	The Output
[image: http://www.vbtutor.net/Images/progra_jan_21_2008_vba4.gif]
	　 








Working with Variables in Excel VBA
	2.1 The Concept of Variables
Variables are like mail boxes in the post office. The contents of the variables changes every now and then, just like the mail boxes. In VBA, variables are areas allocated by the computer memory to hold data. Like the mail boxes, each variable must be given a name. To name a variable in VBA, you have to follow a set of rules, as follows:
	　 
	a) Variable NamesThe following are the rules when naming the variables in VBA 
· It must be less than 255 characters
· No spacing is allowed
· It must not begin with a number
· Period is not permitted
Examples of valid and invalid variable names are displayed in Table 2.1


	　
		Valid Name
	Invalid Name

	My_Car
	My.Car 

	ThisYear
	1NewBoy

	Long_Name_Can_beUSE
	He&HisFather                  *& is not acceptable

	Group88
	Student ID                       * Spacing not allowed


 Table 2.1 : Example of valid and invalid variable names 
 b) Declaring Variables 
In VBA, one needs to declare the variables before using them by assigning names and data types. There are many VBA data types, which can be grossly divided into two types, namely the numeric data types and non-numeric data types 
[bookmark: _Toc123994193]i) Numeric Data Types
Numeric data types are types of  data that consist of numbers, which can be computed mathematically with various standard operators such as add, minus, multiply, divide and so on. In VBA, the numeric data are divided into 7 types, which are summarized in Table 2.2 
	Type
	Storage 
	Range of Values

	Byte
	1 byte
	0 to 255

	Integer
	2 bytes
	-32,768 to 32,767

	Long 
	4 bytes
	-2,147,483,648 to 2,147,483,648

	Single
	4 bytes
	-3.402823E+38 to -1.401298E-45 for negative values 
1.401298E-45 to 3.402823E+38 for positive values.

	Double
	8 bytes
	-1.79769313486232e+308 to -4.94065645841247E-324 for negative values 
4.94065645841247E-324 to 1.79769313486232e+308 for positive values.

	Currency
	8 bytes
	-922,337,203,685,477.5808 to 922,337,203,685,477.5807

	Decimal
	12 bytes
	+/- 79,228,162,514,264,337,593,543,950,335 if no decimal is use 
+/- 7.9228162514264337593543950335 (28 decimal places).


Table 2.2: Numeric Data Types
[bookmark: _Toc123994194]ii) Non-numeric Data Types 
The nonnumeric data types are summarized in Table 2.3 
	Data Type
	Storage
	Range

	String(fixed length)
	Length of string
	1 to 65,400 characters

	String(variable length)
	Length + 10 bytes
	0 to 2 billion characters

	Date
	8 bytes
	January 1, 100 to December 31, 9999

	Boolean
	2 bytes
	True or False

	Object
	4 bytes
	Any embedded object

	Variant(numeric)
	16 bytes
	Any value as large as Double

	Variant(text)
	Length+22 bytes
	Same as variable-length string


 Table 2.3: Nonnumeric Data Types
 You can declare the variables implicitly or explicitly. For example, sum=text1.text means that the variable sum is declared implicitly and ready to receive the input in Text1 textbox. Other examples of implicit declaration are volume=8 and label=”Welcome”. On the other hand, for explicit declaration, variables are normally declared in the general section of the codes' windows using the Dim statement. The format is as follows: 
	Dim variableName as DataType 
Example 2.1 
Dim password As String 
Dim yourName As String 
Dim firstnum As Integer 
Dim secondnum As Integer 
Dim total As Integer 
Dim BirthDay As Date 
	　 


You may also combine them in one line, separating each variable with a comma, as follows: 
Dim password As String, yourName As String, firstnum As Integer.
If the data type is not specified, VB will automatically declare the variable as a Variant. For string declaration, there are two possible formats, one for the variable-length string and another for the fixed-length string. For the variable-length string, just use the same format as Example 2.1 above. However, for the fixed-length string, you have to use the format as shown below:  
 Dim VariableName as String * n
 where n defines the number of characters the string can hold.  For example, Dim yourName as String * 10 mean yourName can hold no more than 10 Characters. 
	Example 2.2
In this example, we declared three types of variables, namely the string, date and currency.
Private Sub CommandButton1_Click()
Dim YourName As String
Dim BirthDay As Date
Dim Income As Currency
 YourName = "Alex"
BirthDay = "1 April 1980"
Income = 1000
Range("A1") = YourName
Range("A2") = BirthDay
Range("A3") = Income
End Sub
	The output screen of Example 2.2
[image: http://excelvbatutor.com/vba_img/vba_Ex2.gif]










Message Box
	Previously we have shown how you can display phrases in a range of cells and also perform arithmetic operations in MS Excel. Today, I shall demonstrate how we can display  message boxes in a MS Excel worksheet . A message box normally acts as a dialog box where users can interact with the computer, it is able to perform certain actions in response to what the user clicks or selects. The format for a message box is as follows:
message=MsgBox(Prompt, Style Value,Title)
	　
　 
	The first argument, Prompt, will display the message in the message box. The Style Value determines what type of command button will appear in the message box. . The Title argument will display the title of the message board. message is a variable that holds values that are returned by the MsgBox ( ) function. The values are determined by the type of buttons being clicked by the users. It has to be declared as Integer data type in the procedure or in the general declaration section. Please refer to Lesson 10 of Visual Basic Tutorial for the detail listings of the Style Value as well as the returned value.
In this example, I create three command buttons which show different Options. I put in a bit of program code in the last button which involves the use of If...Then...Elseif statements.



	[image: http://www.vbtutor.net/Images/progra_jan_21_2008_vbaII_1.gif]
	[image: http://www.vbtutor.net/Images/progra_jan_21_2008_vbaII_2.gif]
This is the message box displayed by clicking the first button
The code follows:
Private Sub CommandButton1_Click()
MsgBox ("Welcome to VBA Programming")
End Sub

	　

The code for the second button
　
Private Sub CommandButton2_Click()

Dim message As Integer
message = MsgBox("Click Yes to Proceed, No to stop", vbYesNoCancel, "Login")
If message = 6 Then
Range("A1").Value = "You may proceed"
ActiveWorkbook.Activate
ElseIf message = 7 Then
ActiveWorkbook.Close
End If

End Sub

The message box displays  Yes, No and Cancel buttons.
[image: http://excelvbatutor.com/vba_img/vba_3_1_2.gif]
　
	　 

The code for the third button:
　
Private Sub CommandButton3_Click()
Dim message As Integer
message = MsgBox("Click Yes to Proceed, No to stop", vbYesNo, "Login")
If message = 6 Then
Range("A1").Value = "You may proceed"
ActiveWorkbook.Activate
ElseIf message = 7 Then
ActiveWorkbook.Close
End If
End Sub

The message box displays Yes and No buttons
[image: http://www.vbtutor.net/Images/progra_jan_22_2008_vbaII_3.gif]


 





		Using If.....Then....Else
Visual Basic Editor in MS Excel is just as powerful as the stand alone Visual Basic compiler in the sense that you can use the same commands in programming. For example, you can use If..Then...Else to control program flow and display certain output based on certain conditions in MS Excel. Here, I am going to demonstrate the concept using one example.
In this program, you place the command button1 on the MS Excel spreadsheet and go into the VB editor by clicking on the button. At the VB editor, key in the program codes as shown on the left.
I use randomize timer and the RND function to generate random numbers. In order to generate random integers between 0 and 100, I combined the syntax Int(Rnd*100). For example, when Rnd=0.6543, then Rnd*100=65.43, and Int(65.43)=65. Using the statement cells(1,1).Value=mark will place the value of 65 into cell(1,1).
Now, based on the mark in cells(1,1), I use the If.......Then....Elseif statements to put the corresponding grade in cells(2,1). So, when you click on command button 1, it will put a random number between 1 and 100 in cells(1,1) and the corresponding grade in cells(2,1).　
The Interface 
[image: http://www.vbtutor.net/Images/progra_jan_23_2008_vbaIII_1.gif]
The Code
Private Sub CommandButton1_Click()
Dim mark As Integer
Dim grade As String
Randomize Timer
mark = Int(Rnd * 100)
Cells(1, 1).Value = mark
If mark < 20 And mark >= 0 Then
grade = "F"
Cells(2, 1).Value = grade
ElseIf mark < 30 And mark >= 20 Then
grade = "E"
Cells(2, 1).Value = grade
ElseIf mark < 40 And mark >= 30 Then
grade = "D"
Cells(2, 1).Value = grade
ElseIf mark < 50 And mark >= 40 Then
grade = "C-"
Cells(2, 1).Value = grade
ElseIf mark < 60 And mark >= 50 Then
grade = "C"
Cells(2, 1).Value = grade
ElseIf mark < 70 And mark >= 60 Then
grade = "C+"
Cells(2, 1).Value = grade
ElseIf mark < 80 And mark >= 70 Then
grade = "B"
Cells(2, 1).Value = grade
ElseIf mark <= 100 And mark >=80 Then
grade = "A"
Cells(2, 1).Value = grade
End If
End Sub





Looping
	Looping is a procedure in  Excel VBA  that performs repetitive tasks. There are  two kinds of loops in Excel VBA, the For.......Next  loop and the Do...Loop . To demonstrate the For....Next loop in Excel VBA, here are two examples:
	　
　 
	Example 1: 
Private Sub CommandButton1_Click()
Dim i As Integer
For i = 1 To 10
Cells(i, 1).Value = i
Next
End Sub
　


In this VBA program, you place the command button 1 on the spreadsheet then click on it to go into the Visual Basic editor. When you click on the button , the VBA program will fill cells(1,1) with the value of 1, cells(2,1) with the value of 2, cells(3,1) with the value of 3......until cells (10,1) with the value of 10. The position of each cell in the Excel spreadsheet is referenced with cells(i,j), where i represents row and j represent column. 
In example 2,we use the nested loop to put the values of i+j from cells(1,1),cells(1,2),cells(1,3),cells(1,4),cells(1,5) ..........until cells(10,5). The code and output are shown below. 
	Example 1
	Example 2

	[image: http://www.vbtutor.net/Images/progra_jan_24_2008_vbaIV_1.gif]
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	Example 2
Private Sub CommandButton1_Click()
Dim i, j As Integer
For i = 1 To 10
For j = 1 To 5
Cells(i, j).Value = i + j
Next j
Next i
End Sub
	





 



DO.........LOOP
	In the previous chapter, you have learned to use the   For........Next loop to execute a repetitive process. In this chapter,  you will learn about another looping method know as the Do Loop. There are four ways you can use the Do Loop as show  below. 
	　 
	i) Do...........Loop While
(ii) Do until.............Loop
(iii) Do while............Loop
(iv) Do............Loop until

	Example 1: 
Arranging numbers in ascending order
Private Sub CommandButton1_Click()
Dim counter As Integer
Do
counter = counter + 1
Cells(counter, 1) = counter
Loop While counter < 10

End Sub
In this example, the program will keep on adding 1 to the preceding counter value as long as the counter value is less than 10. It displays 1 in cells(1,1), 2 in cells(2,1)…. until 10 in cells (10,1).
　
	Example 2: 
Arranging numbers in descending order
Private Sub CommandButton1_Click()
Dim counter As Integer
Do Until counter = 10
counter = counter + 1
Cells(counter, 1) = 11 - counter
Loop

End Sub
　
In this example, the program will keep adding 1 to the preceding counter value until  the counter value reaches 10. It displays 10 in cells(1,1), 9  in cells(2,1)….. until 1 in cells (10,1).
	Examle 3
Private Sub CommandButton1_Click()
Dim counter , sum As Integer
'To set the alignment to center
Range("A1:C11").Select
With Selection
.HorizontalAlignment = xlCenter
End With

Cells(1, 1) = "X"
Cells(1, 2) = "Y"
Cells(1, 3) = "X+Y"

Do While counter < 10
counter = counter + 1
Cells(counter + 1, 1) = counter
Cells(counter + 1, 2) = counter * 2
sum = Cells(counter + 1, 1) + Cells(counter + 1, 2)
Cells(counter + 1, 3) = sum
Loop
End Sub
In this example, the program will display the values of X in cells(1,1) to cells(11,1). The value of Y is X2 and the values are display in column 2, i.e. from cells(2,1) to cells(2,11). Finally, it shows the values of X+Y in column 3, i.e. from cells(3,1) to cells(3,11)
　

	Example 1
[image: http://www.vbtutor.net/Images/progra_jan_25_2008_vbaV_1.gif]
	Example 2
　
[image: http://www.vbtutor.net/Images/progra_jan_25_2008_vbaV_2.gif]

	　 
	Example 3
[image: http://www.vbtutor.net/Images/progra_jan_25_2008_vbaV_3.gif]


 




Select Case.........End Select
	Normally it is sufficient  to use the conditional statement If....Then....Else for multiple options or selections programs. However, if there are too many different cases, the If...Then...Else structure could become too bulky and difficult to debug if problems arise. Fortunately, Visual Basic provides another way to handle complex multiple choice cases, that is, the Select Case.....End Select decision structure. The general format of a Select Case...End Select structure is as follow:
	
	Select Case   variable
Case value 1
     Statement
Case value 2
     Statement
Case value 3
     Statement
.
.
.
.
Case Else

End Select
In the following example, I will show you how to process the grades of students according to the marks given.

	Private Sub CommandButton1_Click()

Dim mark As Single
Dim grade As String
mark = Cells(1, 1).Value
'To set the alignment to center
Range("A1:B1").Select
With Selection
.HorizontalAlignment = xlCenter
End With

Select Case mark
Case 0 To 20
grade = "F"
Cells(1, 2) = grade
Case 20 To 29
grade = "E"
Cells(1, 2) = grade
Case 30 To 39
grade = "D"
Cells(1, 2) = grade
Case 40 To 59
grade = "C"
Cells(1, 2) = grade
Case 60 To 79
grade = "B"
Cells(1, 2) = grade
Case 80 To 100
grade = "A"
Cells(1, 2) = grade
Case Else
grade = "Error!"
Cells(1, 2) = grade
End Select

End Sub
　
	
Explanation:
　
To set the cell align alignment to center, we use the following procedure:
　
Range("A1:B1").Select
With Selection
.HorizontalAlignment = xlCenter
End With
　
We can use the statement case value1 to value 2  to specify the range of values that fulfill the particular case.
　
You should also include the error case where the values entered are out of the range or invalid. For example, if the examination mark is from 0 to 100, then any value out of this range is invalid. In this program, I use case else to handle the error entries.
　
The diagram on the lower left illustrates the output of this example.
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Writing Your First VBA Function in Excel
About User Defined Functions
Excel provides the user with a large collection of ready-made functions, more than enough to satisfy the average user. Many more can be added by installing the various add-ins that are available.
Most calculations can be achieved with what is provided, but it isn't long before you find yourself wishing that there was a function that did a particular job, and you can't find anything suitable in the list. You need a UDF.
A UDF (User Defined Function) is simply a function that you create yourself with VBA. UDFs are often called "Custom Functions". A UDF can remain in a code module attached to a workbook, in which case it will always be available when that workbook is open. Alternatively you can create your own add-in containing one or more functions that you can install into Excel just like a commercial add-in.
UDFs can be accessed by code modules too. Often UDFs are created by developers to work solely within the code of a VBA procedure and the user is never aware of their existence.
Like any function, the UDF can be as simple or as complex as you want. Let's start with an easy one...
A Function to Calculate the Area of a Rectangle
Yes, I know you could do this in your head! The concept is very simple so you can concentrate on the technique.
Suppose you need a function to calculate the area of a rectangle. You look through Excel's collection of functions, but there isn't one suitable. This is the calculation to be done:
AREA = LENGTH x WIDTH
Open a new workbook and then open the Visual Basic Editor (Tools > Macro > Visual Basic Editor or ALT+F11).
	[image: http://www.exceltip.com/images/martin/vbatut01a.gif]
	You will need a module in which to write your function so choose Insert > Module. Into the empty module type: Function Area and press ENTER. 
The Visual Basic Editor completes the line for you and adds an End Function line as if you were creating a subroutine.
So far it looks like this...


Function Area()

End Function
Place your cursor between the brackets after "Area". If you ever wondered what the brackets are for, you are about to find out! We are going to specify the "arguments" that our function will take (an argument is a piece of information needed to do the calculation). Type Length as double, Width as double and click in the empty line underneath. Note that as you type, a scroll box pops-up listing all the things appropriate to what you are typing.
[image: http://www.exceltip.com/images/martin/vbatut01b.gif]
This feature is called Auto List Members. If it doesn't appear either it is switched off (turn it on at Tools > Options > Editor) or you might have made a typing error earlier. It is a very useful check on your syntax. Find the item you need and double-click it to insert it into your code. You can ignore it and just type if you want. Your code now looks like this...
Function Area(Length As Double, Width As Double)

End Function
Declaring the data type of the arguments is not obligatory but makes sense. You could have typed Length, Width and left it as that, but warning Excel what data type to expect helps your code run more quickly and picks up errors in input. The double data type refers to number (which can be very large) and allows fractions.
Now for the calculation itself. In the empty line first press the TAB key to indent your code (making it easier to read) and type Area = Length * Width. Here's the completed code...
Function Area(Length As Double, Width As Double)
    Area = Length * Width
End Function
You will notice another of the Visual Basic Editor's help features pop up as you were typing, Auto Quick Info...
[image: http://www.exceltip.com/images/martin/vbatut01c.gif]
It isn't relevant here. Its purpose is to help you write functions in VBA, by telling you what arguments are required.
You can test your function right away. Switch to the Excel window and enter figures for Length and Width in separate cells. In a third cell enter your function as if it were one of the built-in ones. In this example cell A1 contains the length (17) and cell B1 the width (6.5). In C1 I typed =area(A1,B1) and the new function calculated the area (110.5)...
[image: http://www.exceltip.com/images/martin/vbatut01d.gif]
Sometimes, a function's arguments can be optional. In this example we could make the Width argument optional. Supposing the rectangle happens to be a square with Length and Width equal. To save the user having to enter two arguments we could let them enter just the Length and have the function use that value twice (i.e. multiply Length x Length). So the function knows when it can do this we must include an IF Statement to help it decide.
Change the code so that it looks like this...
Function Area(Length As Double, Optional Width As Variant)
    If IsMissing(Width) Then
        Area = Length * Length
    Else
        Area = Length * Width
    End If
End Function
Note that the data type for Width has been changed to Variant to allow for null values. The function now allows the user to enter just one argument e.g. =area(A1). The IF Statement in the function checks to see if the Width argument has been supplied and calculates accordingly...
[image: http://www.exceltip.com/images/martin/vbatut01e.gif]
Now for a more practical example...
A Function to Calculate Fuel Consumption
I like to keep a check on my car's fuel consumption so when I buy fuel I make a note of the mileage and how much fuel it takes to fill the tank. Here in the UK fuel is sold in litres. The car's milometer (OK, so it's an odometer) records distance in miles. And because I'm too old and stupid to change, I only understand MPG (miles per gallon).
Now if you think that's all a bit sad, how about this. When I get home I open up Excel and enter the data into a worksheet that calculates the MPG for me and charts the car's performance.
The calculation is the number of miles the car has travelled since the last fill-up divided by the number of gallons of fuel used...
MPG = (MILES THIS FILL - MILES LAST FILL) / GALLONS OF FUEL
but because the fuel comes in litres and there are 4.546 litres in a gallon..
MPG = (MILES THIS FILL - MILES LAST FILL) / LITRES OF FUEL x 4.546
Here's how I wrote the function...
Function MPG(StartMiles As Integer, FinishMiles As Integer, Litres As Single)
    MPG = (FinishMiles - StartMiles) / Litres * 4.546
End Function
and here's how it looks on the worksheet...
[image: http://www.exceltip.com/images/martin/vbatut01f.gif]
Not all functions perform mathematical calculations. Here's one that provides information...
[bookmark: dayname]A Function That Gives the Name of the Day
I am often asked if there is a date function that gives the day of the week as text (e.g. Monday). The answer is no*, but it's quite easy to create one. (*Addendum: Did I say no? Check the note below to see the function I forgot!).
Excel has the WEEKDAY function, which returns the day of the week as a number from 1 to 7. You get to choose which day is 1 if you don't like the default (Sunday). In the example below the function returns "5" which I happen to know means "Thursday".
[image: http://www.exceltip.com/images/martin/vbatut01g.gif]
But I don't want to see a number, I want to see "Thursday". I could modify the calculation by adding a VLOOKUP function that referred to a table somewhere containing a list of numbers and a corresponding list of day names. Or I could have the whole thing self-contained with multiple nested IF statements. Too complicated! The answer is a custom function...
Function DayName(InputDate As Date)
    Dim DayNumber As Integer
    DayNumber = Weekday(InputDate, vbSunday)
    Select Case DayNumber
        Case 1
            DayName = "Sunday"
        Case 2
            DayName = "Monday"
        Case 3
            DayName = "Tuesday"
        Case 4
            DayName = "Wednesday"
        Case 5
            DayName = "Thursday"
        Case 6
            DayName = "Friday"
        Case 7
            DayName = "Saturday"
    End Select
End Function
I've called my function "DayName" and it takes a single argument, which I call "InputDate" which (of course) has to be a date. Here's how it works...
· The first line of the function declares a variable that I have called "DayNumber" which will be an Integer (i.e. a whole number). 
· The next line of the function assigns a value to that variable using Excel's WEEKDAY function. The value will be a number between 1 and 7. Although the default is 1=Sunday, I've included it anyway for clarity. 
· Finally a Case Statement examines the value of the variable and returns the appropriate piece of text. 
Here's how it looks on the worksheet...
[image: http://www.exceltip.com/images/martin/vbatut01h.gif]
 
Accessing Your Custom Functions
If a workbook has a VBA code module attached to it that contains custom functions, those functions can be easily addressed within the same workbook as demonstrated in the examples above. You use the function name as if it were one of Excel's built-in functions.
You can also find the functions listed in the Function Wizard (sometimes called the Paste Function tool). Use the wizard to insert a function in the normal way (Insert > Function).
Scroll down the list of function categories to find User Defined and select it to see a list of available UDFs...
[image: http://www.exceltip.com/images/martin/vbatut01i.gif]     [image: http://www.exceltip.com/images/martin/vbatut01j.gif]
You can see that the user defined functions lack any description other than the unhelpful "No help available" message, but you can add a short description...
Make sure you are in the workbook that contains the functions. Go to Tools > Macro > Macros. You won't see your functions listed here but Excel knows about them! In the Macro Name box at the top of the dialog, type the name of the function, then click the dialog's Options button. If the button is greyed out either you've spelled the function name wrong, or you are in the wrong workbook, or it doesn't exist! This opens another dialog into which you can enter a short description of the function. Click OK to save the description and (here's the confusing bit) click Cancel to close the Macro dialog box. Remember to Save the workbook containing the function. Next time you go to the Function Wizard your UDF will have a description...
[image: http://www.exceltip.com/images/martin/vbatut01l.gif]
Like macros, user defined functions can be used in any other workbook as long as the workbook containing them is open. However it is not good practice to do this. Entering the function in a different workbook is not simple. You have to add its host workbook's name to the function name. This isn't difficult if you rely on the Function Wizard, but clumsy to write out manually. The Function Wizard shows the full names of any UDFs in other workbooks...
[bookmark: _GoBack][image: http://www.exceltip.com/images/martin/vbatut01k.gif]
If you open the workbook in which you used the function at a time when the workbook containing the function is closed, you will see an error message in the cell in which you used the function. Excel has forgotten about it! Open the function's host workbook, recalculate, and all is fine again. Fortunately there is a better way. 
If you want to write User Defined Functions for use in more than one workbook the best method is to create an Excel Add-In. Find out how to do this in the tutorial Build an Excel Add-In. 
[bookmark: addendum]Addendum
I really ought to know better! Never, ever, say never! Having told you that there isn't a function that provides the day's name, I have now remembered the one that can. Look at this example... 
[image: http://www.exceltip.com/images/martin/vbatut01m.gif]
The TEXT function returns the value of a cell as text in a specific number format. So in the example I could have chosen =TEXT(A1,"ddd") to return "Thu", =TEXT(A1,"mmmm") to return "September" etc. The Excel's help has some more examples of ways to use this function. 
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